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Logging in to PowerTeacher 
 
Note: If using Power Teacher on an instructional (student) computer, you will have to 
save the Launch Gradebook file into your My Documents and then launch the file. 
 

Open Internet Explorer 

Enter the address  

https://sis.nps.k12.nj.us/teachers  

in the browser address bar 

Press Enter to open the login page 

On the PowerTeacher login page, enter your network username and password 

Press Enter to log in to the PowerTeacher Start Page 

 

Taking Attendance 
 

Navigate to Start Page > Chair icon  

(next to the class for which you want to take  

attendance) 

Select the Date 

Select the Current attendance code 

Click the cell next to a student’s name to assign that code 

Click Submit 

The green light next to the chair indicates that  
your attendance has been submitted to PowerSchool. 
 

Note: Even if all students are present, teachers  
should click the Chair icon to open the  
attendance screen, and then click Submit.  
This tells PowerSchool that the teacher has taken 
 attendance. 
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Adding	Section	Numbers	to	Class	Names	
on	the	Start	page	
 
If you teach more than one class with the same 
name, you can add section numbers to 
distinguish the classes on the Start page. 

  

On the PowerTeacher Start Page, click 
Personalize in the main menu on the left 

Click on the Display Section Number link 

From the Display Section Number on the 
PowerTeacher Home Page dropdown list, 
select Yes 

Click Submit 

 

Note:  

This change will not take effect until the next 
time you log into PowerTeacher.  Note the 
section numbers have been added to the 
class names. 
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Changing Class Names in the 
Gradebook 
 
If you teach more than one class with the same 
name, you can change the way the names 
appear in the Gradebook window, in the Classes 
pane. 

  

On the PowerTeacher Start Page, click the 
arrow next to Gradebook 

On the Tools menu, choose Preferences 

Click on the Section tab, and choose Custom 
Display Name 

Click OK 

In the Classes pane, select the class you wish to 
rename 

Click on the Class Content tab and make sure 
that the Mode is Class Info 

In the Custom Display Name box, type the name 
of the class as you wish it to appear in your 
Gradebook 

Click Save 

Note the new name in the Classes pane 

Repeat for all other classes, starting with step 5 
above 
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Printing a Class Attendance Roster 
 

Navigate to Start Page > Printer icon (next to 
the section for which you want to print reports) 

Select the Class Attendance Audit report 

Select whether to run a Test Print, if so, enter 
the number of pages to print 

Select the Watermark Text, if applicable 

Select the Watermark Mode, if applicable 

Select ASAP for when to print the report 

Click Submit 

On the Report Queue (System) – My Jobs 
page, 

 Click Refresh until the status is 
Completed 

 To open the report in a new window,  
press & hold Ctrl while clicking View  
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Setting Up Categories Based on NPS 
Policy: Deleting, Adding, Editing  
 
Whatever was set up in the previous year will 
carry over to the current year. 
 

Please VERIFY that it is correct. 
 
Before you can create assignments, you must set 
up categories. Categories are groups of the same 
types of assignments. Categories are not class-
specific, eliminating the need to create the same 
categories multiple times for each class. 

On the PowerTeacher Start Page, click the arrow 
next to Gradebook 

On the PowerTeacher Gradebook page, click the 
ScoreSheet  tab 

On ScoreSheet Tab, on the side bar, under the 
Classes pane, verify your current classes. 

PowerTeacher comes with existing Categories.  To 
customize PT Gradebook to meet the NPS Grading 
Policy do the following: 

Delete Categories 

 On the side bar, under the Categories 
pane, highlight Project, click the Minus 
Sign below Categories to delete that 
category.  Click OK on the Delete 
Categories window. 

 On the side bar, under the Categories 
pane,  highlight Quiz, click the Minus 
Sign below Categories to delete that 
category.  Click OK on the Delete 
Categories window. 

 On the side bar, under the Categories 
pane,  highlight Test, click the Minus 
Sign below Categories to delete that 
category.  Click OK on the Delete 
Categories window. 

Note:  Once a Category has had 
assignments assigned to it, that category 
can never be deleted, even in future 
marking period and/or years.  However, it is 
not a problem to have a category with no 
assignments ever assigned to it. 
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Add Categories 
 
To add the Assessments category, on the 
side bar, under the Categories pane highlight 
ALL, then click the Plus Sign below 
Categories.  The Create Assignment 
Category window will open.   Fill in the 
following fields:  

 Name: Assessment 
 Abbreviation: Assess 
 Color: Violet 
 Points Possible: 100 
 Extra Points: 0 
 Score Type: Percentage 
 Include in Final Grade: leave 

checked 
 Description: Assessments 

category will count for 65% of 
the final grade. 

 Click OK 

To add the Class Work and Participation 
category, on the side bar, under the 
Categories pane highlight ALL, then click the 
Plus Sign below Categories.  The Create 
Assignment Category window will open.   Fill 
in the following fields: 

 Name: Class Work and 
Participation 

 Abbreviation: Class Wk/Particip 
 Color: Olive 
 Points Possible: 100 
 Extra Points: 0 
 Score Type: Percentage 
 Include in Final Grade: leave 

checked 
 Description: Class Work and 

Participation category will count 
for 25% of the final grade. 

 Click OK 
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Edit Categories 
 
To edit the Homework category, on the side 
bar, under the Categories pane, double click 
on the Homework category.  The Create 
Assignment Category window will open.  Fill 
in the following fields: 

 Points Possible: 100 
 Extra Points: 0 
 Score Type: Percentage 
 Include in Final Grade: leave 

checked 
 Description: Homework category 

will count for 10% of the final 
grade. 

 Click OK 
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Secondary: Assign Category Weights 
for Final Grades for Year Long 
Classes 
 
 
Category weighting calculates final grades 
based on the weight of each category. 

On the PowerTeacher Start Page, click the 
arrow next to Gradebook 

On the PowerTeacher Gradebook page, click 
the Grade Setup tab 

On the Side Bar, under the Classes pane, 
click on the first year long class. 

Under Reporting Term, double click on Q1. 
(This will open the Q1 window.) 

On the Q1 window, select Category Weights

Click on  + Add Category  

 Select the following categories: 
Assessment, Class Work and 
Participation, Homework 

Click OK 

On the Q1 window, click on the zero in the 
Weight column next to Assessments. Type 
65, hit the Enter key 

On the Q1 window, click on the zero in the 
Weight column next to Class Work and 
Participation. Type 25, hit the Enter key 

On the Q1 window, click on the zero in the 
Weight column next to Homework. Type 10, 
hit the Enter key 

Click Save 
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Secondary: Copy Category Weighting 
to Other Quarters  

 

With the Q1 window open, click the Copy 
button to copy.  This will open the Copy Final 
Grade Setup window. 

Make sure Q1 Only is selected, then click 
OK 

On the Copy Grade Setup window, click Q2, 
Q3, Q4, then click Next 

A message window will open.  Confirm that 
the selections are correct, then click Finish 
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Secondary: Assign Category Weights 
for Final Grades for Semester 1 
Classes 
 
Category weighting calculates final grades 
based on the weight of each category. 

On the PowerTeacher Start Page, click the 
arrow next to Gradebook 

On the PowerTeacher Gradebook page, click 
the Grade Setup tab 

On the Side Bar, under the Classes pane, 
click on the first Semester 1 class 

Under Reporting Term, double click on Q1. 
(This will open the Q1 window) 

On the Q1 window, select Category Weights

Click on  + Add Category  

 Select the following categories: 
Assessment, Class Work and 
Participation, Homework 

Click OK 

On the Q1 window, click on the zero in the 
Weight column next to Assessments. Type 
65, hit the Enter key 

On the Q1 window, click on the zero in the 
Weight column next to Class Work and 
Participation. Type 25, hit the Enter key 

On the Q1 window, click on the zero in the 
Weight column next to Homework. Type 10, 
hit the Enter key 

Click Save 
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Secondary: Copy Category Weighting 
for Semester 1 Classes to Other 
Quarters  
 

With the Q1 window open, click the Copy 
button.  This will open the Copy Final Grade 
Setup window. 

Make sure Q1 Only is selected, then click 
OK 

On the Copy Grade Setup window, click Q2, 
then click Next 

A message window will open.  Confirm that 
the selections are correct, then click Finish 
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Secondary: Assign Category Weights 
for Final Grades for Semester 2 
Classes 
 
Category weighting calculates final grades 
based on the weight of each category. 

On the PowerTeacher Start Page, click the 
arrow next to Gradebook 

On the PowerTeacher Gradebook page, click 
the Grade Setup tab 

On the Side Bar, under the Classes pane, 
click on the first Semester 2 class. 

Under Reporting Term, double click on Q3. 
(This will open the Q3 window.) 

On the Q3 window, select Category Weights

Click on  + Add Category  

 Select the following categories: 
Assessment, Class Work and 
Participation, Homework 

Click OK 

On the Q3 window, click on the zero in the 
Weight column next to Assessments. Type 
65, hit the Enter key 

On the Q3 window, click on the zero in the 
Weight column next to Class Work and 
Participation. Type 25, hit the Enter key 

On the Q3 window, click on the zero in the 
Weight column next to Homework. Type 10, 
hit the Enter key 

Click Save 
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Secondary: Copy Category Weighting 
for Semester 2 Classes to Other 
Quarters  
 

With the Q3 window open, click the Copy 
button.  This will open the Copy Final Grade 
Setup window. 

Make sure Q3 Only is selected, then click 
OK 

On the Copy Grade Setup window, click Q4, 
then click Next 

A message window will open.  Confirm that 
the selections are correct, then click Finish 
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Secondary: Setting up Term Weights 
for Final Grades for Year Long 
Classes 
 
Term weighting calculates final grades based 
on the weight of each term.  

On the PowerTeacher Start Page, click the 
arrow next to Gradebook 

On the PowerTeacher Gradebook page, click 
the Grade Setup tab 

On the Side Bar, under the Classes pane, 
click on the first Year Long class. 

Under Reporting Term, double click on F1. 
(This will open the F1 window.) 

On the F1 window, click Term Weights 

Click on the 100 in the Weight column next 
to Q1. Type 20, hit the Enter key 

Click on the 100 in the Weight column next 
to Q2. Type 20, hit the Enter key 

Click on the100 in the Weight column next to 
E1. Type 10, hit the Enter key 

Click on the 100 in the Weight column next 
to Q3. Type 20, hit the Enter key 

Click on the 100 in the Weight column next 
to Q4. Type 20, hit the Enter key 

Click on the100 in the Weight column next to 
E2. Type 10, hit the Enter key 

Click Save 

 

NOTE:  This will also copy the Category 
Weights set up in each of the quarters. 
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Secondary: Copy Term Weights to 
Other Year Long classes  

 

With the F1 window open, click the Copy 
button.  This will open the Copy Final Grade 
Setup window. 

Make sure Entire Class is selected, then 
click OK 

Carefully select ONLY the Year Long 
classes (NOT the Semester long classes) 

Click Next 

A message window will open.  Confirm that 
the selections are correct, then click Finish 
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Secondary: Setting up Term Weights 
for Final Grades for Semester 1 
Classes 
 
Term weighting calculates final grades based 
on the weight of each term.  

On the PowerTeacher Start Page, click the 
arrow next to Gradebook 

On the PowerTeacher Gradebook page, click 
the Grade Setup tab 

On the Side Bar, under the Classes pane, 
click on the first Semester 1 class. 

Under Reporting Term, double click on F1. 
(This will open the F1 window.) 

On the F1 window, click Term Weights 

Click on the 100 in the Weight column next 
to Q1. Type 40, hit the Enter key 

On the F1 window, click on the 100 in the 
Weight column next to Q2. Type 40, hit the 
Enter key 

On the F1 window, click on the100 in the 
Weight column next to E1. Type 10, hit the 
Enter key 

On the F1 window, click on the100 in the 
Weight column next to E2. Type 10, hit the 
Enter key 

Click Save 
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Secondary: Copy Term Weights to 
Other Semester 1 Classes  
 
 

With the F1 window open, click the Copy 
button.  This will open the Copy Final Grade 
Setup window. 

Make sure Entire Class is selected, then 
click OK 

Carefully select ONLY the Semester Long 
classes  

Click Next 

A message window will open.  Confirm that 
the selections are correct, then click Finish 

 

NOTE:  This will also copy the Category 
Weights set up in each of the quarters. 
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Secondary: Setting up Term Weights 
for Final Grades for Semester 2 
Classes 
 
Term weighting calculates final grades based 
on the weight of each term.  

On the PowerTeacher Start Page, click the 
arrow next to Gradebook 

On the PowerTeacher Gradebook page, click 
the Grade Setup tab 

On the Side Bar, under the Classes pane, 
click on the first Semester 2 class. 

Under Reporting Term, double click on F1. 
(This will open the F1 window.) 

On the F1 window, click Term Weights 

Click on the 100 in the Weight column next 
to Q3. Type 40, hit the Enter key 

On the F1 window, click on the 100 in the 
Weight column next to Q4. Type 40, hit the 
Enter key 

On the F1 window, click on the100 in the 
Weight column next to E1. Type 10, hit the 
Enter key 

On the F1 window, click on the100 in the 
Weight column next to E2. Type 10, hit the 
Enter key 

Click Save 
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Secondary: Copy Term Weights to 
Other Semester 2 Classes 
 
 

With the F1 window open, click the Copy 
button.  This will open the Copy Final Grade 
Setup window. 

Make sure Entire Class is selected, then 
click OK 

Carefully select ONLY the Semester 2 
classes  

Click Next 

A message window will open.  Confirm that 
the selections are correct, then click Finish 

 

 

NOTE:  This will also copy the Category Weights set up in each of the quarters. 
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Elementary: Assign Category 
Weights for Final Grades for Year 
Long Classes 
	
 
Category weighting calculates final grades 
based on the weight of each category. 

On the PowerTeacher Start Page, click the 
arrow next to Gradebook 

On the PowerTeacher Gradebook page, click 
the Grade Setup tab 

On the Side Bar, under the Classes pane, click 
on the first class, after Homeroom 

Under Reporting Term, double click on Q1. 
(This will open the Q1 window.) 

On the Q1 window, select Category Weights 

Click on  + Add Category  

 Select the following categories: Assessment, 
Class Work and Participation, Homework 

Click OK 

On the Q1 window, click on the zero in the 
Weight column next to Assessments. Type 
65, hit the Enter key 

On the Q1 window, click on the zero in the 
Weight column next to Class Work and 
Participation. Type 25, hit the Enter key 

On the Q1 window, click on the zero in the 
Weight column next to Homework. Type 10, 
hit the Enter key 

Click Save 
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Elementary: Copy Category 
Weighting to Other  
 
 
With the Q1 window open, click the Copy 
button to copy.  This will open the Copy Final 
Grade Setup window. 

Make sure Q1 Only is selected, then click OK 

On the Copy Grade Setup window, click Q2, 
Q3, Q4, then click Next 

A message window open.  Confirm that the 
selections are correct, then click Finish 
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Elementary: Setting up Term Weights 
for Final Grades  
 
Term weighting calculates final grades based 
on the weight of each term.  

On the PowerTeacher Start Page, click the 
arrow next to Gradebook 

On the PowerTeacher Gradebook page, click 
the Setup tab 

On the Side Bar, under the Classes pane, 
click on the first class. 

Under Reporting Term, double click on F1. 
(This will open the F1 window.) 

On the F1 window, click Term Weights 

On the F1 window, click on the 100 in the 
Weight column next to Q1. Type 25, hit the 
Enter key 

On the F1 window, click on the 100 in the 
Weight column next to Q2. Type 25, hit the 
Enter key 

On the F1 window, click on the100 in the 
Weight column next to Q3. Type 25, hit the 
Enter key 

On the F1 window, click on the100 in the 
Weight column next to Q4. Type 25, hit the 
Enter key 

Click Save 
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Elementary: Copy Term Weights to 
Other Classes 
 

With the F1 window open, click the Copy 
button.  This will open the Copy Final Grade 
Setup window 

Make sure Entire Class is selected, then 
click OK 

Carefully select ALL other classes EXCEPT 
Homeroom and Lunch 

Click Next 

A message window will open.  Confirm that 
the selections are correct, then click Finish 

 

NOTE:  This will also copy the Category 
Weights set up in each of the quarters. 
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Create Assignments 
 
 
Assignments can be created one at a time as 
you progress through the term, or they can be 
set up for the entire term before the term starts. 

  

On the PowerTeacher Start Page, click the 
arrow next to Gradebook 

On the PowerTeacher Gradebook page, click 
the Assignments  tab 

On the Side Bar, under the Classes pane, click 
on the class for which you wish to create 
assignments 

Click the Assignments tab 

Click the Plus sign on the bottom of the 
Assignments window.  This will open the New 
Assignment window. 

In the New Assignment window, fill in the 
following fields: 

 Name 

 Category 

 Date Due (date should be in the date 
range of the marking cycle) 

 Description 

Confirm the information in the following fields: 

 Score type is Percentage 

 Points Possible is 100 

 Extra Points is 0 

 Weight is 1.00  

 Include in Final Grade is checked 

Click Save 

(See Notes on next page.) 
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Note:   

To give an Assignment more weight, change 
the Weight field to a higher number.  (Ex: If a 
chapter test is weighted twice as much as a 
quiz, change the Weight field from 1.0 to 2.0). 

To change the Publish date on the assignment, 
click the Publish tab on the New Assignment 
window.  Select when to publish the assignment.
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Edit Assignments 
 
Edit assignments if changes need to be made 
to the information attached to a particular 
assignment. 

 

On the PowerTeacher Start Page, click the 
arrow next to Gradebook 

On the PowerTeacher Gradebook page, click 
the Assignments  tab 

On the Side Bar, under the Classes pane, click 
on the class for which you wish to edit 
assignments 

Double click the assignment to edit 

Make the appropriate changes 

Click Save 
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Copy Assignments 
 
Use the Copy Assignments function to copy 
assignments from one class to other classes. 

On the PowerTeacher Start Page, click the 
arrow next to Gradebook 

On the PowerTeacher Gradebook page, click 
the Assignments  tab 

On the Side Bar, under the Classes pane, 
click on the class from which you wish to copy 
assignments 

On the Menu Bar, click Tools, select Copy 
Assignments.  This will open the Copy 
Assignments window. 

Select the assignment(s) to be copied 

Click Next 

Select  the class(es) to copy to 

Click OK 

 

Copy Assignments from one year to another 

 

Change to the year you want to copy the          
assignment(s) from. 

On the Side Bar, under the Classes pane, 
click on the class from which you wish to 
copy assignments 

On the Menu Bar, click Tools, select Copy 
Assignments.  This will open the Copy 
Assignments window 

Select the assignment(s) to be copied 

Click Next 

Select  the year/term to copy to 

Select the class(es) to copy to 

Click OK 
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Delete Assignments 
 
Assignments can be deleted.  If an assignment 
does not have scores, the Delete Assignment 
window states, "Are you sure you want to 
delete Assignment [name]?" 

If an assignment has scores, the Delete 
Assignment window states, "This assignment 
has scores. Are you sure you want to delete 
assignment [name] and all associated scores?" 

 

On the PowerTeacher Start Page, click the 
arrow next to Gradebook 

On the PowerTeacher Gradebook page, click 
the Assignments  tab 

On the Side Bar, under the Classes pane, 
click on the class from which you wish to 
delete assignments 

Highlight the assignment to delete 

Click the Minus sign on the bottom of the 
Assignment window 

A message window will open.  Confirm the 
deletion, then click Yes 
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Entering Scores for Assignments 
 
Student scores, for assignments, can be entered 
from the ScoreSheet window or Score Inspector. 

 

On the PowerTeacher Start Page, click the 
arrow next to Gradebook 

On the PowerTeacher Gradebook page, click 
the ScoreSheet  tab 

On the Score Sheet tab, on the Side Bar, 
under the Classes pane, click on the class for 
which you wish to enter scores 

Click in the cell to enter scores 

 

Note: Right mouse click on the assignment to 
access a drop down menu of options or click on 
the Menu Bar, select Tools to access the 
options below:  

 Score Inspector: to attach a comment 
to a score or mark it late, missing, etc. 

 Fill Scores: to mass fill scores 
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Individual Student Report 
 
Run the Individual Student Report to 
generate class scores by assignment, and the 
final grade for each reporting term, listed in a 
one page per student layout. 

 

On the PowerTeacher Start Page, click the 
arrow next to Gradebook 

On the PowerTeacher Gradebook page, click 
the Reports tab 

On the side bar, under the Classes pane, 
highlight the class for which you wish to print 
reports.   

On the side bar, under the Student Groups 
pane, double click Active.  This will open a 
list of students assigned to that class.   

To select certain students, hold the Ctrl key 
and highlight the names or do not highlight 
any names to print the entire class. 

On the Reports page, double click 
Individual Student Report.  This will open 
the Individual Student Report window. 

On the Individual Student Report window, 
click the Criteria tab.  Fill in the following 
information: 

 Output Type: PDF 

 Sections: Selected Class 

 Student: All Enrolled will print the 
entire class.  Selected Groups and/or 
Students will print the students you 
selected 

 Student Field: Student Name 

 Abbreviate: Leave Assignments and 
Categories blank 

 Include: check Final Grades, 
Assignments, Comments, Categories 
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 Date Range: Click the down arrow to 
select the cycle to print 

On the Individual Student Reports window, 
click the Layout tab.  Fill in the following 
information: 

 Report Title: Give the report a title 

 Page Break: check On Students 

 Top Note: check Include and Bold to 
type a note you wish to print on the top 
of the report. 

 Bottom Note: check Include and Bold 
to type a note you wish to print on the 
bottom of the report. 

 Signature Line: check Include 

Click Run Report 

At the Report Complete window select Save 
Report to save an electronic copy of the 
report.  Select Open Report to open and 
print the report. 
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Entering Comments for Progress 
Reports  
 
Comments can be entered from the ScoreSheet 
window using the Score Inspector. 

 

On the PowerTeacher Start Page, click the 
arrow next to Gradebook 

On the PowerTeacher Gradebook page, click 
the ScoreSheet tab 

On the Score Sheet tab, on the Side Bar, 
under the Classes pane, click on the class for 
which you wish to enter comments 

Make sure that the Reporting Term is set to 
the correct Cycle 

Highlight the student’s name, then right-click in 
the cell under the Final Grade column and 
choose Show Score Inspector 

 

 

 

 

Note that the Student and Reporting Term 
are correct 

 

You may enter a narrative comment in the 
comment box 
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You may also choose comments from the bank 
of comments on the Comment tab 

Click the comment you wish to choose, then 
click the Insert Selected button  

The comment(s) you choose will be placed in 
the Comment box 

If you wish to enter comment(s) for more 
students, simply use the arrow to the right of 
the student’s name to navigate to the next 
student Above or Below in your class list 

Click Close when you are done entering 
comments for all students 

 

 

 

 

Note:  

 

 After you have clicked Close, note the 
little blue C in the Final Grade column.  
You can view the comments by using your 
mouse to point to the little blue C. 

 

**Any comments entered for the 
progress reports, if not changed or 
removed will affect what is printed on 
the report cards. 
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Print Progress Reports or Report Cards in 
PowerTeacher 
 
Progress Reports and Report Cards can be printed for 
1 student, 1 class or all the students you teach. 

 

To print for 1 student: 

 

On the PowerTeacher Start Page, click the 
Backpack for the class in which the student is a 
member  

In the left pane click the name of the student 

From the dropdown list on the upper right choose 
Print a Report 

On the Print a Report screen, from the drop down 
select the report you wish to print 

To insert a Watermark, choose Custom from the 
dropdown, type in NPS in the box below 

Choose When to Print 

Click Submit – this will take you to the Report 
Queue 

See Instructions on How to View Reports on the 
Report Queue 
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Print a Progress Report or Report Card for 
1 Class 
 

On the PowerTeacher Start Page, click the Printer 
icon for the class for which you wish to print either 
Progress Reports or Report Cards 

On the Print Class Reports screen, from the drop 
down select the report you wish to print 

If you wish to run a Test print, you can check the 
check box and indicate the number of pages you 
wish to print 

To insert a Watermark, choose Custom from the 
dropdown, type in NPS in the box below 

Choose When to Print 

Click Submit – this will take you to the Report 
Queue 

See Instructions on How to View Reports on the 
Report Queue 
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Print a Progress Report or Report Card for 
All the Students You Teach 
 

On the PowerTeacher Start Page, on the Main 
Menu on the left, click Reports 

On the Reports for All Students screen,  from the 
drop down select the report you wish to print 

If you wish to run a Test print, you can check the 
check box and indicate the number of pages you 
wish to print 

To insert a Watermark, choose Custom from the 
dropdown, type in NPS in the box below 

Choose When to Print 

Click Submit – this will take you to the Report 
Queue 

See Instructions on How to View Reports on the 
Report Queue 
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View Reports on the Report Queue 
 

Reports remain on the Report Queue for 90 days or 
until you delete them.  They are listed in order on the 
report queue from the most recent on the top to the 
oldest on the bottom of the list. 

 

On the PowerTeacher Start Page, click the paper 
icon to the left of the Logout button.  This opens the 
Report Queue window.  If you have just submitted a 
report, you will automatically be taken to the Report 
Queue window 

The Status may say Pending, Running or 
Completed.  You may not view nor print the report 
until the Status says Completed.  You can keep 
clicking the Refresh link next to My Jobs until the 
Status is Completed or you can go and do other 
work and check back to the Report Queue later 

When the Status says Completed, right-click on the 
View link to Open in New Tab 

 

 

Note: 

 

To delete reports that you no longer need from the 
Report Queue, simply click the trash can icon next to 
the report you wish to delete.  Be advised that you will 
not be warned – the report will just be deleted! 
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End of Cycle – Grades K-8 Entering Subject 
Skills and 21st Century Skills  
 
At the end of each Cycle enter the skills marks for all 
subject skills and 21st Century Life Skills. 

        

On the PowerTeacher Start Page, click the arrow next 
to Gradebook 
        

On the PowerTeacher Gradebook page, click the    
ScoreSheet  tab 
        

On the Score Sheet tab, on the Side Bar, under the  
Classes pane, click on the class for which you wish to  
enter skill marks 
  

Click the Final Grades button 

 

Highlight the student’s name, then right mouse click 
in the cell of the skill.  A drop down menu will open.  
Select Grades to access the options below:  

+     Exceeds grade level expectations 

*      Meets grade level expectations 

-      Does not meet grade level expectations 

/      Not assessed at this time 

 

Click Save      
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End of Cycle - Comments 
 

 Elementary Report Cards 

  

Comments:  ability to write a narrative- Grades K-5 
only 
 

 Grades K-5 Homeroom teachers will write a 
narrative in the comment box (Maximum of 
1,000 characters) for their students instead of 
selecting a comment code for each of the 
subjects taught by the homeroom teacher.   
 

 The Homeroom teacher will enter the narrative 
in the 21st Century Life and Career Skills 
course in the comment box.  (See the section 
on Entering Comments for Progress Reports for 
directions on how to enter a narrative 
comment.) 
 

 All non- core teachers will select one NPS 
comment code from the drop down selection for 
their courses.  Or if the teacher wants to select 
two comments they must type in the code #s 
separated by a comma.  Ex. 01,03 

 
 Grade 6-8 teachers will select one NPS 

comment code from the drop down selection for 
their courses. Or if the teacher wants to select 
two comments they must type in the code #s 
separated by a comma.  Ex.  01,03 
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End of Cycle – Grades 6-12 
 
Final grades and comments must be verified 
by teachers BEFORE grades are stored for 
printing on report cards. 

On the PowerTeacher Start Page, click the 
arrow next to Gradebook 

On the PowerTeacher Gradebook page, click 
the Reports tab 

With the Reports tab selected, on the Side 
Bar, under the Classes pane, click on the 
class for which you wish to verify grades 

Under Name, double-click on Final Grade 
and Comment Verification.  This will open 
up a pane below 

On the Criteria tab choose the following: 

Output Type: PDF 

Sections: Selected Class 

Students: All Enrolled (includes active & 
inactive students) 

Student Field: Student Name 

Include: Course Grade 

Check Grade and Comment check boxes, 
only 

Choose the appropriate Cycle from the 
Reporting Term dropdown 

On the Layout tab, check the check box to 
Include a Signature Line 

Click Run Report 

Click Open to open and view the report on 
your screen or click Save to save the report 
wherever you choose. 

Note:  Carefully review the Final Grade and 
Comments for each student.  If there are any 
errors, go back to your Scoresheet tab in the 
Gradebook to make changes.  After making all 
corrections, rerun the Final Grade and 
Comment Verification report, sign and date, 
and submit to your administrator. 
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End of Cycle – Grades K-5 
 
Final grades and standards must be verified by 
teachers BEFORE grades are stored for 
printing on report cards. 

On the PowerTeacher Start Page, click the 
arrow next to Gradebook 

On the PowerTeacher Gradebook page, click 
the Reports tab 

With the Reports tab selected, on the Side 
Bar, under the Classes pane, click on the 
class for which you wish to verify grades and 
standards 

Under Name, double-click on Standards 
Report.  This will open up a pane below 

On the Criteria tab choose the following: 

Report Layout: Class Spreadsheet  

Output Type: PDF 

Sections: Selected Class 

Students: All Enrolled (includes active & 
inactive students) 

Student Field: Student Name 

Include: Standard Name 

Check Overall Section Grade check box only 

Choose the appropriate Cycle from the 
Reporting Term dropdown 

On the Layout tab, check the check box to 
Include a Signature Line 

Click Run Report 

Click Open to open and view the report on 
your screen or click Save to save the report 
wherever you choose. 

Note:  Carefully review the Final Grade and 
Standards for each student.  If there are any 
errors, go back to your Scoresheet tab in the 
Gradebook to make changes.  After making all 
corrections, rerun the Standards report, sign 
and date, and submit to your administrator. 
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Final Grade and Comment 
Verification Report 
 
Verify final grades and standards for active 
students BEFORE grades are stored in Power 
School and printed on report cards. 

 

On the PowerTeacher Start Page, click the 
arrow next to Gradebook 

On the PowerTeacher Gradebook page, 
click the Reports tab 

With the Reports tab selected, on the Side 
Bar, under the Classes pane, click on the 
class for which you wish to verify grades and 
standards 

On the Side Bar, under the Student 
Groups, click on Active 

Under Name, double-click on Final Grade 
and Comment Verification.  This will open 
up a pane below 

On the Criteria tab choose the following: 

Report Layout: Class Spreadsheet  

Output Type: PDF 

Sections: Selected Class 

Students: Selected Groups and/or Students 
(includes only active students) 

Student Field: Student Name 

Include: Course Grade 

Check Grade and Comment box 

Choose the appropriate Cycle from the 
Reporting Term dropdown 

On the Layout tab, check the check box to 
Include a Signature Line 

Click Run Report 

Click Open to open and view the report on 
your screen or click Save to save the report 
wherever you choose. 
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Entering Mid-Term & Final Grades 
For S1 Semester-Long Classes 
 
You must have already completed the correct 
Grade Setup based on NPS guidelines, i.e.,  
for S1 semester-long classes, the F1 final 
grade will be 40% of Q1, 40% of Q2,10% of E1 
and 10% of E2.  . 
 
Entering Mid-Term Grade 
 

In the Gradebook, select the S1 semester-
long class. 

Navigate to the Assignments tab.  Insure 
that the Reporting Term is set to E1. 

Click the plus sign at the bottom of the 
Assignments window to create a new 
assignment.  This will open a new window 
below. 

Enter the following values: 

Name:  Mid-Term Exam 

Abbreviation:  Mid-Term Exam 

Category:  Assessments 

Score Type:  Percentage 

Points Possible:  100 

Weight:  1.0 

Date Due:  11/15/2012 or 11/16/2012 

Include in Final Grade:  Must be checked 

Description:  The Mid-Term Exam will 
count for 10% of the final grade for 
semester long classes. 

Click Save 

 

 

 

 

 

 

 



Newark Public Schools  
 

September, 2012 Page 44 of 53 

 

The procedure for entering the final exam 
grade is very similar as follows: 

Entering Final Exam Grade 

In the Gradebook, select the S1 semester-
long class. 

Navigate to the Assignments tab.  Insure 
that the Reporting Term is set to E2. 

Click the plus sign at the bottom of the 
Assignments window to create a new 
assignment.  This will open a new window 
below.  (Do NOT simply change the contents 
in the window below – this would edit the 
Mid-Term exam criteria – you MUST click 
the plus sign to enter a new assignment for 
the final exam grade) 

Enter the following values: 

Name:  Final Exam 

Abbreviation:  Final Exam 

Category:  Assessments 

Score Type:  Percentage 

Points Possible:  100 

Weight:  1.0 

Date Due:  2/4/2012 or 2/5/2012 

Include in Final Grade:  Must be checked 

Description:  The Final Exam will count 
for 10% of the final grade for semester 
long classes. 

Click Save 
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Entering Mid-Term & Final Grades 
For S2 Semester-Long Classes 
 
You must have already completed the correct 
Grade Setup based on NPS guidelines, i.e.,  
for S2 semester-long classes, the F1 final 
grade will be 40% of Q3, 40% of Q4,10% of E1 
and 10% of E2.of E2.   
 
Entering Mid-Term Grade 
 

In the Gradebook, select the S2 semester-
long class. 

Navigate to the Assignments tab.  Insure 
that the Reporting Term is set to E1. 

Click the plus sign at the bottom of the 
Assignments window to create a new 
assignment.  This will open a new window 
below. 

Enter the following values: 

Name:  Mid-Term Exam 

Abbreviation:  Mid-Term Exam 

Category:  Assessments 

Score Type:  Percentage 

Points Possible:  100 

Weight:  1.0 

Date Due:  4/22/2013 or 4/23/2013 

Include in Final Grade:  Must be checked 

Description:  The Mid-Term Exam will 
count for 10% of the final grade for 
semester long classes. 

Click Save 

The procedure for entering the final exam 
grade is very similar as follows: 
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Entering Final Exam Grade 
 
In the Gradebook, select the S2 semester-
long class. 

Navigate to the Assignments tab.  Insure 
that the Reporting Term is set to E2. 

Click the plus sign at the bottom of the 
Assignments window to create a new 
assignment.  This will open a new window 
below.  (Do NOT simply change the contents in 
the window below – this would edit the Mid-
Term exam criteria – you MUST click the plus 
sign to enter a new assignment for the final 
exam grade) 

Enter the following values: 

Name:  Final Exam 

Abbreviation:  Final Exam 

Category:  Assessments 

Score Type:  Percentage 

Points Possible:  100 

Weight:  1.0 

Date Due:  6/27/2013 or 6/28/2013 

Include in Final Grade:  Must be checked 

Description:  The Final Exam will count 
for 10% of the final grade for semester 
long classes. 

Click Save 
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Entering Mid-Term & Final Grades 
For Year-Long Classes 
 
You must have already completed the correct 
Grade Setup based on NPS guidelines, i.e.,  
for year-long classes, the F1 final grade will be  
20% of Q1, 20% of Q2.  20% of Q3, 20% of 
Q4, 10% of E1 and 10% of E2.  
 
 Entering Mid-Term Grade 
 

In the Gradebook, select the year-long class.

Navigate to the Assignments tab.  Insure 
that the Reporting Term is set to E1. 

Click the plus sign at the bottom of the 
Assignments window to create a new 
assignment.  This will open a new window 
below. 

Enter the following values: 

Name:  Mid-Term Exam 

Abbreviation:  Mid-Term Exam 

Category:  Assessments 

Score Type:  Percentage 

Points Possible:  100 

Weight:  1.0 

Date Due:  2/4/2013 or 2/5/2013 

Include in Final Grade:  Must be checked 

Description: The Mid-Term Exam will 
count for 10% of the final grade for year 
long classes. 

 

Click Save 

 

 

The procedure for entering the final exam 
grade is very similar as follows: 
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Entering Final Exam Grade 

 

 

In the Gradebook, select the year-long class.

Navigate to the Assignments tab.  Insure 
that the Reporting Term is set to E2. 

Click the plus sign at the bottom of the 
Assignments window to create a new 
assignment.  This will open a new window 
below.  (Do NOT simply change the contents 
in the window below – this would edit the 
Mid-Term exam criteria – you MUST click 
the plus sign to enter a new assignment for 
the final exam grade) 

Enter the following values: 

Name:  Final Exam 

Abbreviation:  Final Exam 

Category:  Assessments 

Score Type:  Percentage 

Points Possible:  100 

Weight:  1.0 

Date Due:  6/27/2013 or 6/28/2013 

Include in Final Grade:  Must be checked 

Description: The Final Exam will count for 
10% of the final grade for year long 
classes. 

 

 

Click Save 
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Elementary: Copying Grade Setup to 
New Sections 
 

Grade setup for all new sections must be 
copied from the grade setup for existing 
sections in order for the final grade to be 
calculated correctly. 

 

Select an existing section already having the 
correct Grade Setup as per the NPS criteria.  

Select the Grade Setup tab.   

Verify that for each cycle (Q1, Q2, Q3, Q4), 
Category Weights are set to be 65% for 
Assessments, 25% for Class Work & 
Participation, and 10% for Homework.   

Also verify that for F1, Term Weights are set 
to be 25% for Q1, 25% for Q2, 25% for Q3 
and 25% for Q4.   

NOTE: If you have not already completed 
grade setup for any existing sections as per 
NPS criteria, see the PowerTeacher 
Gradebook manual for instructions on 
Elementary: Assign Category Weights 
for Final Grades, and Elementary: Assign 
Term Weights for Final Grades. 

 

In the Grade Setup tab for the existing 
section with the correct Grade Setup, double-
click on F1 under Reporting Term.  Click the 
Copy button in the lower window. 

 

 

The Copy Final Grade Setup window opens.  
Verify that Entire class is the option selected.  
Click OK. 
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The Copy Grade Setup window opens.  
Choose the new section or sections, for 
which you wish to copy the grade setup.  
Click Next.  Verify the information on the 
next window and click Finish. 

The grade setup for F1 as well as for all 4 
cycles, Q1, Q2, Q3, and Q4 has been 
successfully copied to all new sections. 
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Copying Q1 Final Grade for Dropped 
Students 
 
Students who have been dropped from one 
section and moved to another section must 
have their final grade manually copied from Q1 
in the old section to Q1 in the new section.  
This must be done before the end of the 
year to ensure that the student’s final grade for 
F1 is calculated correctly. 
 
 

Select the old section from which students 
have been dropped.  Under Student Groups 
on the left, double-click on the Dropped 
folder.  The dropped students will be 
displayed below in gray. 

Navigate to the Reports tab.  Under Name, 
double-click on Scoresheet.  This will open a 
window below. 

Choose the following options on the Criteria 
tab: 

Students:  Selected Groups and/or 
Students 

Items to Include:  check Final Grades and 
choose Q1 from the dropdown list 

Date Range:  Q1 

All other default options are correct. 

Click Run Report. 

The Scoresheet report will show the final 
grade for each of these students for Q1.  Now 
these grades must be manually copied as 
follows. 
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Navigate to the Scoresheet tab.  Select the 
new section to which the students have 
been moved.  Notice that now the students’ 
names are listed in the Scoresheet as they 
are Active in the new section. 

For the Reporting Term, choose Q1 from the 
dropdown list.  Notice there are no final 
grades for these students for Q1 as they 
were not active in this section for Q1.  Their 
final grades for Q1 must be manually 
input. 

In the (Q1) Final Grade column, right-click 
on the first student row, and choose Show 
Score Inspector from the shortcut menu. 

Verify the Student and make sure the 
Reporting Term specifies Q1.  Check the 
Manual Override box.  Type in the Percent 
and choose the letter Grade from the 
dropdown list as was indicated on the 
Scoresheet report. 

Use the down arrow to the right of the 
student’s name to navigate to the next 
student.  Follow the same procedure for each 
of the students whose grades must be 
manually input. 

When finished with all students, click Close 
to close the Score Inspector window. 

Click Save in the Gradebook window. 

 

VERY IMPORTANT!  Please make sure to 
change the Reporting Term back to the 
current cycle in the Scoresheet tab. 
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Accessing Q2 Data for Dropped 
Students 
 
 

In the PowerTeacher Gradebook, select the 
class the students had been enrolled in 
originally, from which you wish to retrieve 
data.  On the Scoresheet tab, you will not 
see these students’ names as it only displays 
those students who are currently active in the 
class. 

On the left-hand side under Student Groups, 
double-click on the Dropped folder.  You will 
see a number in parentheses next to the 
word Dropped.  This indicates how many 
students have been dropped from this class.  
These students will be listed below the 
Dropped folder in gray. 

Navigate to the Reports tab.  Under Name, 
double-click on Scoresheet.  This will open a 
window below.  On the Criteria tab next to 
Students, select the option for Selected 
Groups and/or Students.  Next to Date 
Range, select the option for Q2.  All other 
default options selected are correct.  

Click Run Report. 

The report generated will display all 
assignment and grading information you had 
already entered for these students.  The 
assignments may be copied from the old 
section to the new section.  Only the grades 
must now be manually input for these 
students in the correct section where these 
students are now active.  Print the report for 
your reference. 

Navigate to the Scoresheet tab.  See the 
PowerTeacher Gradebook manual for 
instructions on how to Copy Assignments. 
Select the new section where the moved 
students are now located.  Now proceed to 
manually enter grades for the students. 

 

 


